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Power point program is one of Microsoft's products, and is used to design electronic
presentations where electronic display consists of a set of slides and used as a means to illustrate
the idea of clarifying certain to be shown in the auditorium of the number of attendees. Where is
prepared slides containing the first and the slides on texts and images, sounds and graphics can
move text and images in the presentation.

Mode of operation of PowerPoint program: -
Start >> all program >> Microsoft Office >> Microsoft Office Power Point 2007

Then begins to work PowerPoint program.

Outline of the screen: -

When you run the program window appears PowerPoint as specified in the following figure
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Note in PowerPoint 2007 changed significantly is the area the top of the PowerPoint. Instead of menus
and toolbars that I used to see them in PowerPoint 2003, there is a long bar appears at the top screen
contains many visible commands clearly and ranked in groups .called on this tape long "ribbon", which
1s now considered the control center, which will help you to create a display presentation. So do not be
a need to search for them in menus or toolbars are not displayed.
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Consists of "' tape "' from the following tabs : -

e tab" Home " Home Here 1s all the commands displayed as buttons , it supports a variety of
tasks , including copy and paste , and add slides, change the slide layout , and format the text
and the appointment of his site , and search and replace text .

e tab "Insert " Insert Here 1s all you may need to put in the slide - from tables , pictures, diagrams
, charts and text boxes to the sounds and hyperlinks , headers and footers .

e tab " design " Design from which you can choose the form of incomplete segments includes
background design , fonts, and color scheme , and then customize this format.

e tab " movements " Animations Here 1s all animation effects . Is the basic movements are easier
to add to the lists or charts .

e tab " slide show " Slide Show you can determine the color of a pen or a certain segment of the
start of 1t. You can also record narration , and review the offer quickly , and make some other
preparatory tasks .

e tab " Review " Review where you find the spell checker and research services . Mark team have
used annotations to review the presentation , and then see these comments .

e tab" View " View you can make a quick switch to a view " page notes ," and show grid lines ,
or organize all open presentations in the frame.

e It also shows the status bar at the bottom of the display screen displays PowerPoint us
information, such as the slide number and the name of the design template applied to the slide
that 1s displayed and the display buttons and a sliding zoom in / out to zoom view slide 1n or out
. Clicking buttons minus ( -) and plus ( ) as well as to perform the same thing .
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Display Presentation: -

Microsoft PowerPoint by default called any new file 1s created on behalf of the presentation and the
first presentation will be named default ( Presentation 1) and 1ts extension ppt which means that the full
name be ( presentation 1.ppt), the presentation may consist of a single chip or multiple slides , which 1n
turn may contain text, images, sounds and graphics can Post an sounds and kinetics for the texts ,
images and objects .and any presentation is created to be given the name of its own in order to be
practical conservation through it and in this way 1t becomes an electronic file stored in the computer's
memory so you can refer to it at any moment In order to open and view the contents or modify it .
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Slide:-
Constructivism 1s the unit that make up the presentation and can be placed where writings, pictures,
objects, backgrounds, kinetic effects, sound effects and hyperlinks.

Slab slides (part slides)

Yemen, which 1s part of the program window as in the following figure contains part of the slide on
the top (Outline tab) and (tab slides); where you can switch between them by clicking on the right-ease
tab.
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It represents the outline text slide - slide where
the text appears in outline form for each slide in
the presentation, as in the current format, which 1s
the best place to start writing content, and Post an
amendment, delete, and move slides and text as
desired.

Tab slides

To move to this tab to see the slides in
the presentation miniature-sized pictures -
during editing. Thumbnail facilitate | 5
mobility in the presentation and see the | D) sie A2 '
effects of design changes. You can also o
rearrange the slides, add, or delete them. mos

FO%

As shown in the figure. s
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Buttons Display

Are the buttons on the bottom of the screen the program from the left side in the status bar by clicking
Right-ease on the display button where you can through buttons display to determine how the slide
show and the buttons represent three main ways to view slides and each view has a certain style,
namely: -

e normal view
e Slide Sorter View
e slideshow

Slideshow Slide Sorter View Normal view

T

= 58 3| |

And you can access them in a manner and within seconds "View" tab, click the Group "offers ways to
display your presentation,” and then choose the right offer, as in the following figure.

J Home Insert Design Animations Slide Show Review View

3 | v Ruler Cuim | = Arrange All | ! | -
Gridlines i Grayscale — 3 Cascade - —d
Normal| Slide Notes 5|IE|E Slide Handout Notes View Zoom Fitto New switch Macros
Sorter Page Show ' Master Master Master Message Bar pirection Window |l Pure Black and White | window C 1“'3‘” SPIit | Windows *

Presentation Views Show/Hide Zoom Color/Grayscale Window Macros

N .

'
Buttons Display

“INormal view
The default display 1s to create and modify slides in PowerPoint contains most of the tools you need to
write the user and the presentation and design. To display the work of three aspects: to the right part of

the slide, and to the left task pane; In the bottom part notes.

— Slide Sorter View

Slide Sorter View is a special offer for slides in the form of thumbnails, when you have finished
creating your presentation, edit, Slide Sorter gives an overall picture of him making it easier to
rearrange the slides, or added, or deleted, and preview the effects of the transition and animation
effects.

=

=0 .
Showing ''slideshow'’

Is a slide show to fill the computer screen, are viewed full-screen presentation, as will be seen
attendance. Where you can see how the 1mage will look like, and timing, and movies, and animated

elements, and transition effects in the actual display.
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Part observations: -

The lower part 1s 1n normal view and show the phrase (click to add notes) where you write your feedback that
you want to accompany a slide. You can print these notes as pages or notes displayed when you save a
presentation as a Web page. .Where You can add notes on the content of each slide, by clicking the right-ease
in the part of the notes as shown in the figure below, and the page is displayed notes of "View" tab and in the
group of "methods of display presentations,” and then notes page where Post an editing notes.

Silea Tl 3Ly @l ¢

/' B d

Click here to add

Dealing with slide :-

e data entry

To enter data into the slide click inside the rectangle appropriate. "Click to add title" and then type the

text you Trgb.nas on the slide always resides within a place called the deputy a text box (text box) or
be a form of automatic (Auto shape).

e 1nsert a new slide insert New Slide

To insert a new blank slide, select the slide you want to insert a slide and then do one of the following
actions:

_—

o the tab "Home Home" click the "slices Slides", click the new slide J as 1n the following figure.

-
— Home Insert

Design Animations
"'4"“‘3 o Cut \ .= Layout ~
= =3 Copy | E Reset
Paste : New | B
- F':*.ii'!‘i-:'l;: P'._.'Iiﬁ?.'ii- SlldE v R DEIEtE
Clipboard F~ Slides

e Right-click on the current slide Yemen menu appears and choose a new chip as in the following
figure

e of the keyboard, click on the ctrl key with the key +M

First Class



Assistant Lecturer — Diyala university/College of Engineering
Omar Abbood Imran [r E Microsoft Office Power Point 2007 Chemical Department
2015 - 2016 L

e Delete Slide

To delete the slice , select the slide you want to delete and do one of the following : -

e the Home tab , click the segments , click Delete .

e Right-click on the current slide Yemen menu appears and choose Delete slice

e C(Click on the DELETE key or Backspace on your keyboard to delete the slide.

e (Copy, Cut ( transfer ) , paste slide (copy, cut, paste slide) -

e Seclect the slide you want to copy and do one of the following actions: - — | Home | msert

e Click Right-click the selected slide , and then click Copy to copy or =) | & Cut

e From Home Tab in part clipboard to click Copy button .22 or button paste F',a;j = Copy

e pressing CTRL+ C to copy and press CTRL+ X from the keyboard. - | J Format Painter
Clipboard F

e Paste Slide

After a Copy command or the Cut command segments, must use the Paste command and execute this
command, click the slide you want to be followed by slides copied or shredded and do one of the

following actions:

e (Click Right-click the slide that you want to be followed by slides copied or shredded, and then
click Paste.

h

e From Home Tab in part clipboard, click the Paste button =
e pressing CTRL V from the keyboard.

-""-.__-""'. L)

1 &

o Hint: - slide can be moved 1n a way that drag and select the slide, which you want to move and
click the left mouse button and drag it to a new position in the board or part of the slide, and look for a
horizontal line beneath the slide that you want to be followed, then release the mouse button.

e Hide Slide

Select the slide you want to hide and do one of the following actions:

e the tab "slide show" in the "preparation”, click "Hide slide," as in the following figure

Animations Slide Show Heview View
:,,;?il. ~ \ w9 Record Marration | R
—= | (=¥ Rehearse Timings =Fl St
Set Up Hide

tlide Show Slide ¥ Use Rehearsed Timings L):

Set Up
e C(Click Right-click the slide you want to hide, and then hide the slice.
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Symbol appears hidden slide @ with the slide number inside, next to the slide that conceal. As in
the following figure.

The hidden slide

&
@ Hint: - keep the slide in the file, even though they be hidden while running the presentation.

= repeat slides

Select the slide that you want to replicate and do one of the following actions: -

e Press the keys (CTRL D) of the keyboard
e (Click Right-click the slide that you want to replicate, and then slice duplicate as in the following figure

oIl ASLoodl) amamll | "Offce moasr | Y wom ) S

Duplicate slides are included directly in the bottom of the slide that you specity.

o
Hint: -

* To determine a single slice, click it.

* To select multiple consecutive slides, click the first slide and press SHIFT, and then click the last slice want
to be 1dentified.

* To select multiple non-consecutive slides, press CTRL, and then click each slide you want to select
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= Add a background to your presentation
* add attributes of the slide.

Note 1in Microsoft Office PowerPoint 2007, that features replace design templates ( design template
. A tile contains the styles 1n a presentation , including the type and size of bullets and fonts, sizes
and placements placeholders , and design background, and the mobilization of color schemes ),
which was used 1n versions Previous . Can coordinate the entire presentation quickly and easily to
give the appearance of professional and talk him through the application of an attribute.

The feature is a set of formatting choices that include a set of ( theme colors and lines of the
attribute and the effects of the attribute ) .

The features contained within " tab design " in the group " attributes " . Where when you put the
cursor over a thumbnail 1mage of the feature , you can preview how the pattern of the background

to the presentation. If you want to apply this style, you clicked. As in the following figure.
Aa } Aa E | i:\a ‘Aa |
Page Slide THT =m me= mormes | EEee——

Aa Aa Aa
Em EREEE i
Setup Orientation ~ -

Page Setup Themes

d
_,/ Home Insert Design Animations Slide Show Review View

In the Design tab, in the Themes group, click the More button ™ , offer more features, and you can

change the colors, lines or lines and the effects of packaging used. The application of these changes to
the presentation slides km 1in the following figure.

= | Q| Effects -

= allocation patterns backdrop for the presentation
Patterns backgrounds are displayed in thumbnail images in the gallery
e i {?j] Background Styles -
patterns backgrounds. When you put the cursor over a thumbnail 1mage of
the background pattern, you can preview how the pattern of the background RIBCEAEE O AR,
to the presentation. If you want to apply this style, you clicked. Background E
e (lick the slide or slides you want to add style to the background.

e the tab "design" in the group "background”, click the arrow next to the patterns backgrounds.
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graphics chipset as in the figure above

e Click Right-click the background style that you want, as in the following figure

v iee— .. e

<l

L

And then do one of the following:

m
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e To apply a style background on selected slides, click Apply to selected slides.

e To apply a style to the background on all the slides in the presentation, click Apply to All

Shides.

e (Coordination Background: -

You can work formats for background slide through
patterns backgrounds where you can color a schism
Post an article or use a photo as wallpaper or as in Fig.

h 8
| L
@ Tip: If you wish to hide background graphics click the check box to hide background

o -

o -

[ ASH el L Baslad

Create a presentation

First: - Create a presentation using blank presentation: -

The first way: click the button Microsoft Office, click New, and
then click an empty talk and the bottom of the molds, and then

double

-Click down the offer of a blank and empty talk, or click on.
Also Created 1n shape.

E_;l! iy LBy g 0 -lf— soft Office Online o8 o

|| s e | T _|
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The second way - through the right-ease to click Jon the New button from the Quick Access Toolbar
as shown 1n Figure

Create a presentation using templates installed

(-84 0

O

'] : I i-r--
I ]
I |

Installed templates: - 1s a file that contains the styles in a presentation, including the type and size of

bullets, fonts, and background design, and color schemes to mobilize, where you can apply to a
presentation 1n order to provide the appearance of high-quality designer and fully. And you can. Apply

the template to all slides or on specific segments, and application templates, perform the following

steps: -

Click the button Microsoft Office, click New, and then click New, and then click the bottom of the
installed templates Templates, and then double-click the one installed templates, or click on the

Created

SSwllS j5.0 poadl | €
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Certificates

Flyers

Slide layout: - 1identifies and defines the form of slide elements that can be contained in such slide, text
box, 1mage, table, etc., as a program that provides a set of PowerPoint charts for each planning its own
use and you can apply a slide layout By following these steps: -

e Click Right-click the slide, and then click on the slide layout. Appears select the appropriate

planning layouts as in Figure below.

AR EAEA AR AR R R RN AN A B

s
&6 Ulgic aijléo A Qe D
_.
A0 i 93 500 B0 et 95 LS00 Fls

First Class

B iriss Sy )
By 50 ATer josas

CrlEr AT 395 0 o BEvex]]

Aoer gy aaill pea=F H3le]

11



Assistant Lecturer — Diyala university/College of Engineering
Omar Abbood Imran I_D Microsoft Office Power Point 2007 Chemical Department
2015 - 2016

Add the effects of mobility and audio to slides

In order to make the presentation more attractive and the impact on the public , who will deliver a presentation
to them you must add some of that kinetic effects and audio so that it does not feel bored audience . Effects that
can be added to the presentation : -

e slide transitions
e kinetic effects and audio

Add transitions between slides

Transitional phase 1s the kinetic effects that can be applied when the transition process between the chip and the
other like the transition from the first slide to the second tranche at this moment can make the second slide
appears on the screen from the bottom or top or in the form of diagonal or curtains or boxes etc. ... and you can
also control the speed of the transition etfect for each slide , you can also add sound .

To add transitions between slides Perform the following procedure: -

On the " tab " movements , in the group "Move to this segment ," click the influence of slide transitions you
want to apply to this segment . To add the same transition to all slides in the presentation , click Apply to
Jsete e ool All In the case of adding different stages of transition between slides in the presentation are
choosing the effect of slide transitions you want to apply to this segment.

Animations = SlideShow  Review  View L7

| e T

Transition to This Slide

2\ Transition Sound: [No Sound] | Advance Slide

_i;i_ Transition Speed: Fast * | 'V OnMouse Click

™ 13l Apply To Al Automatically After; 00:00

To appoint a speed slide transitions, in the group was transferred to this segment, click the arrow next to the

speed of transitions, and then select the desired speed. Speed of Tab shares click speed box and select an
appropriate speed .

(Slow, medium, fast).

i [Zrg.0 W] JULEENI e 2,
T' B | s8] BV =l ol %Jﬂsf—ﬂ_
2 arflal ]

Add sound to slide transitions
Tab movements, the group was transferred to this evil PLATE, click the arrow next to the transfer of
voice, and then do one of the following

e To add a sound from the list, select the sound you want.

e To add a sound that does not exist in the list, select another voice, locate the sound you want to
add, then click OK.

First Class
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To add a voice to the other stages of the transitional segments, repeat steps.
Slideshow at a mouse click

Tab progress within the slice, select the check at a mouse click

Set the timing of the slideshow

Tab progress within the slice, select the check box automatically after then enter the number of
seconds you want the appearance of which slide on the screen.

sy aanlly D 207T
orslodl j0:ll e

Can be applied to different stages of the transition between the slides and you can transition phase
itself to all the slides in the presentation by clicking on the "Apply to all slides”

Kinetic effects and audio -:

To add a visual effect or an audio special to text or an object where they can work influences
the kinetics of different objects inside the slhide, or text, or graphics, charts, tables and other other
things can also add sounds and make these effects coincides with the movement of the object. For
example, you can make bullet points move to the inside of the right, each word individually, or hear
the sound of applause when you show a picture. To do so, do the following procedure.

=] o | ety 1]
First: - apply an effect on the movement of objects in the slide T ::Uyd o j
e (lick the text or object you want to move it. s PR
e tab "movement,” in the group ”mwemerj:ts”,. select the animation eftect ot i B —
that you want to move from the menu. As in Fig. T daae aS,> |

Second: - Create custom animation effect applied to text or object individually
e click the text or object that you want to want to move it.
e tab "movement,” in the group "movements”, click Custom Animation.

e appears in the Custom Animation task pane, click, Add Effect button and select the appropriate
influence from the menu as in the figure below.

First Class
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The effect of changing the Kinetic IR T .
To replace the effect of kinetic movement, text or other object impact, [t 2] [z seeme =]
follow these steps: - = = e
Select the title you want to change the effect. E e o SRR
You will notice that the Add button effect | ¥ 2#5 =l 9¥may change SR e e S
Tgiraly button and then click the Change button [~ Pk e 6 Fo = Sloieio 1V igec[=]]

expand its own sub-menu, and choose New from the menu effect. As in
the following figure.

Remove the effect of moving

In the Custom Animation task pane, in the list of movements allocated, click the title which has the
Las e

allyl ==

effect of movement that you want to remove
Click.

Add voice to the movement
Must be've already added the impact of the _
. . N el Eo saadl
movement of the text or object before adding voice _ )
- . - . . ol vey el (S
e C(lick the slide that contains the animation
effect that you want to add sound to it.
e tab movement, movement 1n the group,
click Custom Animation.
e the Custom Animation task pane, click the
arrow left of the animation effect in the Custom Animation list, and then click animation effects.

e tab effect, within enhancements, click the arrow in the menu sound, and then do one of the
following:
To add a sound from the menu, click sound.
To add a sound file, click the voice of another, and then locate the audio file you want to use.

szl ace eaddl M3

sl il
L 1 ¥ |
padzoll Lesoill hbhsall slgbl

all;l
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Save the presentation
Created after the presentation and writing inside has to be saved to keep him permanently and save the

file for the first time, you will be prompted to give a name for the file extension PowerPoint ppt

format "= and to make the save, follow one of the following steps: -

E

e (ffice of the menu button, click Save - —_

e toolbar quick access click on the Save button
In both cases, a dialog box appears in which special conservation: -
Type the file name
Select a place to save the file
Click the Save button

PowerPoint file is saved in the form of display is ready

You can in PowerPoint to save the file , which 1s an — T t&lm
extension ppt file format slide show is ready and who 1s | | Meme  Dumemodfied  Tpe S

extending pps power point show)) of the advantages of | “=" = "

this type of file that is ready for viewing as soon as | % ="

double-clicking on the file icon i1t does not open the .

program PowerPoint , but it is running presentation and ”:‘“’

start a slide show directed became like an executable file | .o

and be as - B i ——
To make the save , follow these steps : - EE===i S —
Office of the menu button , click Save as ‘Liii”f“*"“““ '

A dialog box will appear on behalf of special
conservation as in the following figure

From the dialog box
e Type the name of the file when the file name option.
e Select where to save the file when the option of saving 1n.
e Select the type of conservation and be the "power point show" at the option of the Save as type.
e C(Click the Save button.

First Class
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Set the direction of the slide

Design tab, in the Page Setup group, click the arrow next to the direction of the slide has been
1dentified trend slide horizontal or vertical.

Printing : -

il
oL’ o1l Aasanai )| Asro.all “—fff
, : ST i

] —al |
ST T Ll L=l slaz]

You can print the entire presentation of the segments, and the outline, and notes pages, and audience

handouts using colors, or grayscale, or black and white only. You can also print the slides, or bulletins,
or notes pages, or pages outline specific.

- ™ l- "Ir-- {-‘1 y - w . "
e (Click the button Microsoft Office™ ", and click the arrow next to Print, and then click Print

= |
P =
eyl B
| - ot | @ Microsoft XPS Document Writer - Vet 2al |
| T | _ . alia=a s S =t |
Microsoft XPS Document Writer s Egall
P SPort: rgdoodl
wilo ol Al [[] 5L Gkl
2 eanzll mae S Lo in]] D En§
o — A — A et Aallz=ll Fery oZall 0 N SRR
: 0 e Bae
Determine ) 1 P aiatl ()
th b f i i TR -T2 Sl zn 2wl aZell o elBlEay sl s 2l oZall _olE ] Jl=5-s]l, o0
€ nNumpocer o
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_;._nE_'..ll sl=l] I [ e [ ) _] L& vl

Print each slide

Add a frame around
each slice of printed

Choose the type of
material you want
to print
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Run the slide show: - it | S5 pas o wbiimat
_ G . : . . . ~ e — % E:i_l_l - "'_-_T
First: - to start the slide show from within Microsoft ope i K9 (10 o] Elj Ep
PowerPoint corp0dll bl (7 —E = = =
: : ' - ) slox]  popealag] | ailpd pope | upddl o 0
Open the presentation that you want to view it as a slide | _ sy guaens Eig e vl L ol L
ShDW alag] Ejl_-,_a.:ﬂl U LE FL

Perform one of the tollowing: -

e Click the slideshow bottom = left of the window PowerPoint.
e tab "slide show" in the group "Start Slideshow", click "from the beginning"” or "from the current

slide”
e press FS.

Termination of the presentation: -

You can at any time terminate Presentation without waiting for the arrival of the last slice. To end the
offer at any time, follow one of the methods The following -:

1. press the Esc key on the keyboard.

2. Right-click on the slide during the presentation and select "Exit Offer" from the shortcut menu.
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